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Chapter 1

Introduction

This document describes the features and functions of the PCl Express® Control Plane
targeted reference design (TRD). The TRD comprises a base design and a user extension
design. The user extension design adds custom logic on top of the base design. The
pre-built user extension design in this TRD adds another AXI block RAM controller to the
design and sets up ingress translations through BAR4 to access this memory space.

Overview

The TRD targets the Kintex® UltraScale™ XCKU040-2FFVA1156E FPGA running on the
KCU105 evaluation board. It demonstrates a control plane application using a PCI Express
Endpoint block in a x1 Gen1 configuration. Simple base address register (BAR)-mapped
read and write transactions are demonstrated using a kernel mode software driver
controlled by the Control & Monitoring graphical user interface (GUI). The top-level block
diagram of the TRD is shown in Figure 1-1.

KCU105 Evaluation Board
XCKU040-2FFVA1156E FPGA
Host Computer
PROCESSOR s
o
o
Gl o
gr(i:vI:r Root PCle T % AXI P c ey
| | Roo PFO0, BAR4
e (Kernel Complex | H "g Bridge S
space) x1 Gent > =l 64 bits at [i:
Link g 62.5 MHz PVTMON
: Registers | SYSMON
(PFO, BAR2)
dappe
Integrated block on FPGA Custom logic in FPGA . Third-party IP and FPGA
. Xilinx in-house IP Software running on Component on host computer
host computer UGS18_c1_01_021315

Figure 1-1: KCU105 PCI Express Control Plane Targeted Reference Design
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An Expresso DMA Bridge Core from Northwest Logic (NWL) [Ref 1] is used to demonstrate
PCle-to-AXI conversion of transactions. The downstream slaves include a power, voltage,
and temperature (PVT) module monitoring parameters from the FPGA system monitor and
AXI block RAM IP targeted to BARs.

Features

The TRD includes these features:

« PCle x1 Gen1 Endpoint operating at 2.5 GigaTransfers per second (GT/s) per
lane/direction

- Single physical function with support for three 64-bit BARs
« DMA Bridge IP Core
- Ingress address translation capability
o AXI3 interface
« 64-bit kernel space drivers for Linux and Windows 7, which run on the host computer

« Control and monitoring graphical user interface (GUI)

Resource Utilization

Table 1-1 and Table 1-2 list the resources used by the base and user extension designs after
synthesis. Place and route can alter these numbers based on placements and routing paths.
These numbers are to be used as a rough estimate of resource utilization. These numbers
might vary based on the version of the TRD and the tools used to regenerate the design.

Table 1-1: Base Design Resource Utilization

Resource Type Available Used Usage (%)

CLB registers 484,800 43,896 9.05
CLB LUT 242,400 27,431 11.32
Block RAM 600 22 3.66
MMCME3_ADV 10 1 10

Global Clock Buffers 240 3 1.25
BUFG_GT 120 5 417
SYSMONE1 1 1 100
IOB 520 16 3.08
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Table 1-1: Base Design Resource Utilization (Cont’d)

Resource Type Available Used Usage (%)
GTHE3_CHANNEL 20 1 5
GTHE3_COMMON 5 0 0

Table 1-2: User Extension Design Resource Utilization

Resource Type Available Used Usage (%)
CLB Registers 484,800 44,395 9.16
CLB LUTs 242,400 27,817 11.48
Block RAM 600 24 4
MMCME3_ADV 10 1 10
Global Clock Buffers 240 3 1.25
BUFG_GT 120 5 417
SYSMONE1 1 1 100
IOB 520 16 3.08
GTHE3_CHANNEL 20 1 5
GTHE3_COMMON 5 0 0
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Chapter 2

Setup

This chapter identifies the hardware and software requirements, and the preliminary setup
procedures required prior to bringing up the targeted reference design.

Requirements

Hardware

Board and Peripherals

« KCU105 board with the Kintex® UltraScale™ XCKU040-2FFVA1156E FPGA
» USB cable, standard-A plug to micro-B plug (Digilent cable)

« Power supply: 100 VAC-240 VAC input, 12 VDC 5.0A output

« ATX power supply

« ATX power supply adapter

Computers

A control computer is required to run the Vivado® Design Suite and confige the on-board
FPGA. It can be a laptop or desktop computer with any operating system supported by
Vivado tools, such as Redhat Linux or Microsoft® Windows 7.

The reference design test configuration requires a host computer comprised of the chassis,
containing a motherboard with a PCI Express slot, monitor, keyboard, and mouse. A DVD
drive is also required if a Linux operating system is used. If a Windows 7 operating system
is used, the 64-bit Windows 7 OS and the Java SE Development Kit 7 must be installed.

Software

Vivado Design Suite 2017.3 is required. The Fedora 20 LiveDVD, on which the TRD software
and GUI run, is only required if a Linux operating system is used.
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Preliminary Setup

Complete these tasks before bringing up the design.

Install the Vivado Design Suite

Install Vivado Design Suite 2017.3 on the control computer. Follow the installation
instructions provided in Vivado Design Suite User Guide Release Notes, Installation, and
Licensing (UG973) [Ref 2].

Download the Targeted Reference Design Files

1. Download r df 0305- kcul105-trd01-2017- 3. zi p from the Xilinx Kintex UltraScale
FPGA KCU105 Evaluation Kit - Documentation & Designs website. This ZIP file contains
the hardware design, software drivers, and application GUI executables.

2. Extract the contents of the file to a working directory.
3. The extracted contents are located at <wor ki ng_di r >/ kcul05_control _pl ane.

The TRD directory structure is described in Appendix A, Directory Structure.

Install TRD Drivers on the Host Computer (Windows 7)

Note: This section provides steps to install KUCon-TRD drivers and is only applicable to a host
computer running Windows 7 64-bit OS. If running Linux, proceed to Set DIP Switches, page 11.

This section includes steps to set up and install KUCon-TRD drivers in a host computer
running the Windows 7 64-bit OS.

Disable Driver Signature Enforcement

Note: Windows only allows drivers with valid signatures obtained from trusted certificate
authorities to load in Windows 7 64-bit OS. Windows drivers provided for this reference design do
not have a valid signature. Therefore, you have to disable driver signature enforcement on the host
computer, as follows:

1. Power up the host system. Press F8 to go to the Advanced Boot Options menu.

2. Select the Disable Driver Signature Enforcement option as shown in Figure 2-1, and
press Enter.
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Advanced Boot Options

Choose Advanced options for: Disable Signature Enforcement Manually!!! (Press
F3) [VirtualkpD]
{(Use the arrow keys to highlight your choice.)

air Your Computer

Mode
Mode with Networking
Mode with Command Prompt

Enable Boot Logging

Enable low-resolution video

Debugging Mode

Disable automatic restart on system failure

Disable Driver Signature Enforcement

Disable Early Launch Anti-Malware Driver
start windows Mormally

Description: Allows drivers containing improper signatures to be loaded.

ENTER=Choose ESC=Cance]l

UG918_c2_01_040315

Figure 2-1: Disable Driver Signature Enforcement
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Install Drivers

1. From the Windows explorer, navigate to the folder in which the reference design is
downloaded (<di r >\ kcul05_control _pl ane\ softwar e\ w ndows\) and run the
setup file with Administrator privileges, as shown in Figure 2-2.

E setup
Open
B Run as adrministrator
Troubleshoot cormpatibility
Edit weith Wirm

Restore previous wersions

Send to 3
Cut

Copy

Create shortcout
Delete

Fename

Froperties

UG918_c2 02 040715
Figure 2-2: Run the Setup File with Administrator Privileges

Click Next after the InstallShield Wizard opens.

Click Next to install to the default folder; or click Change to install to a different folder.

Click Install to begin driver installation.

ok W

A warning screen displays as the drivers are installed, because the drivers are not signed
by a trusted certificate authority yet. To install the drivers, ignore the warning message
and click Install this driver software anyway. This warning message pops up two
times. Repeat this step.

6. After installation is complete, click Finish to exit the InstallShield Wizard.

Set DIP Switches

Ensure that the DIP switches and jumpers on the KCU105 board are set to the factory
default settings as identified in the Kintex UltraScale FPGA KCU105 Evaluation Board User
Guide (UG917) [Ref 3].
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Install the KCU105 Board

1. Remove all rubber feet and standoffs from the KCU105 board.

2. Power down the host chassis and disconnect the power cord.

CAUTION! Remove the power cord to prevent electrical shock or damage to the KCU105 board or other
components.

3. Ensure that the host computer is powered off.

4. Open the chassis. Select a vacant PCle Gen3-capable expansion slot and remove the
expansion cover at the back of the chassis.

5. Plug the KCU105 board into the PCle connector slot, as shown in Figure 2-3.

UG918_c3_01_091314

Figure 2-3: PCle Connector Slot
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6. Connect the ATX power supply to the KCU105 board using the ATX power supply
adapter cable as shown in Figure 2-4.

Note: A 100 VAC-240 VAC input, 12 VDC 5.0A output external power supply can be substituted for
the ATX power supply.

UG918_c3_02_040715

Figure 2-4: Power Supply Connection to the KCU105 Board

7. Slide the KCU105 board power switch SW1 to the ON position (ON/OFF is marked on the
board).
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Chapter 3

Bringing Up the Design

This chapter describes how to bring up and test the targeted reference design.

Set the Host System to Boot from the LiveDVD
(Linux)

Note: This section is only applicable to host computers running Linux. If running Windows 7,
proceed to Configure the FPGA.

1. Power on the host system and stop it in BIOS to select options to boot from the DVD
drive. BIOS options are entered by pressing DEL, F12, or F2 keys on most computers.

Note: If an external power supply is used instead of the ATX power, the FPGA can be configured
first. Then power on the host system.

2. Place the Fedora 20 LiveDVD into the DVD drive.
3. Select the option to boot from DVD.
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Configure the FPGA

While in BIOS, program the FPGA with the BIT file:

1. Connect the standard-A plug to micro-B plug USB cable to the JTAG port on the KCU105
board and to the control computer laptop as shown in Figure 3-1.

Note: The host system can remain powered on.

CONTROL
COMPUTER /
LAPTOP

= [ —

—

5"’tﬂ/

e
}
1
/
-
shift

UG918_c3_03_042115

Figure 3-1: Connect the USB Cable to the KCU105 Board and Control Computer

Note: Figure 3-1 shows a Rev C board. The USB JTAG connector is on the PCle panel for
production boards.
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2. Launch the Vivado® Integrated Design Environment (IDE) on the control computer:

a. Select Start > All Programs > Xilinx Design Tools > Vivado 2017.3 > Vivado
2017.3.

b. On the getting started page, click Open Hardware Manager (Figure 3-2).

Vivado 2017.1

Eile Flow Tools Window  Help Ci~ Quick Access

VIVADO

HLx Editions

Quick Start

l Create Project >
Open Proje

Open Example Project >

Tasks

Manage IP >

Hardware Manager >

Learning Center

Documentation and Tutorials >

UG918_c3_04_070717

Figure 3-2: Vivado IDE Getting Started Page, Open Hardware Manager
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3. Open the connection wizard to initiate a connection to the KCU105 board:

a. Click Open New Target (Figure 3-3).

a2do 201“&—

File Edit Tools Window Layout View Help Cluick Access

= £

Fl

HARDWARE MANAGER - unconnected
o Mo hardware target is open. Open target

£ Auto Connect
Hardware

Recent Targets 3

= ]

Open Mew Target...

Mo content

UG918_c3_05_070717

Figure 3-3: Using the User Assistance Bar to Open a Hardware Target
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4. Configure the wizard to establish connection with the KCU105 board by selecting the
default value on each wizard page. Click Next > Next > Next > Finish.

a. In the hardware view, right-click xcku040 and click Program Device (Figure 3-4).

-

¢ Vivado 2017.1

File  Edit Tools Window  Layout View  Help Quick Access
=, - = o ¥  Dashboard ~

HARDWARE MANAGER - localhostixiling_tcfiDigilent’210308957 309

o There are no debug cores. Program device Refresh device

Hardware ? 00X

Q| = | & &

Name Status

~ § localhost (1) Connected
~ @ xiling_tcfiDigilent’2103089573...  Open

~ {8 xcku040_0 (1)

Hardware Device Properties..
& SysMon (System Monito

Program Device. .
Verify Device. ..

* Refresh Device

: Add Configuration Memory Device. .

Boot from Configuration Memory Device

Hardware Device Properties Program BBR Key...

& xcku040_0 Clear BBR Key...
Name: xcku04a_0 Program eFUSE Registers...
Part: xcku040 Exportto Spreadsheeat..
ID code: 13822093 | |l

UG918_c3_06_070717

Figure 3-4: Select Device to Program
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b. In the Bitstream file field, browse to the location of the BIT file
<wor ki ng_di r>/ kcul05 control plane/ready to test/trd0Ol.bit and
click Program (see Figure 3-5).

¢ Program Device [&J

Select a bitstream programming file and download it to your hardware device. You can optionally
select a debug probes file that corresponds to the debug cores contained in the bitstream '
programming file.

Bitstream file; JIUGEH8!201?.ﬂdesigm’kcmUS_control_pIanea’ready_to_testl‘trdﬂ‘l.biﬂ |E|

Debug probes file: E‘

v+ Enable end of startup check

r’:"\
\2) Program Cancel

UG918_c3_07_070717

Figure 3-5: Program Device Window

5. Check the status of the design by observing the GPIO LEDs positioned at the top right
corner of the KCU105 board (Figure 3-6). After FPGA configuration, the LED status from
left to right indicate

o LED position 1: Heartbeat LED, flashes if the PCle user clock is present
o LED position 0: ON if the PCle link is UP

Note: The LED position numbering used here matches with the LED positions on the board.

PCle User Clock Presence

PCle Link UP

UG918_c3_08_091314

Figure 3-6: GPIO LED Indicators
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6. Exit the BIOS and let the system boot.

7. On most systems, this gives a second reset on the PCle connector, which should discover
the device during enumeration.

o To know that the PCle Endpoint is discovered, see Check for PCle Devices, page 21.

o If the PCle Endpoint is not discovered, reboot the system. Do not power off.
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Run the Design on the Host Computer

This section provides instructions to run the reference design on either a host computer
with Linux, or a host computer with Windows 7.

Run the Design on a Linux Host Computer

Setup

This section describes how to set up the reference design using the Linux drivers and the
Fedora 20 LiveDVD.

Figure 3-7 shows different boot stages of Fedora 20. After you reach the third screen,
shown in Figure 3-7, click the Try Fedora option, then click Close. It is recommended that
you run the Fedora operating system from the DVD.

& CAUTION! /f you want to install Fedora 20 on the hard drive connected to the host system, click the
Install to Hard Drive option. BE CAREFUL! This option erases any files on the hard disk!

UGY918_c3_09_011415

Figure 3-7: Fedora 20 Boot Stages

Check for PCle Devices

1. After the Fedora 20 OS boots, open a terminal and use Ispci to see a list of PCle devices
detected by the host:

$ Ispci | grep -i xilinx
The following is displayed:
03: 00.0 Menory controller: Xilinx Corporation Device 8011

Note: If the host computer does not detect the Xilinx PCle Endpoint, | spci does not show a
Xilinx device.

PCI Express Control Plane TRD www.xilinx.com Send Feedback 21
UG918 (v2017.3) October 30, 2017 [—\/—]


http://www.xilinx.com
https://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG918&Title=KCU105%20PCI%20Express%20Control%20Plane%20TRD%20User%20Guide&releaseVersion=2017.3&docPage=21

8 XI LINX Chapter 3: Bringing Up the Design

ALL PROGRAMMABLE-~

Run the Design

1. Navigate to the <wor ki ng_di r >/ kcul05_cont rol _pl ane/ sof t war e folder and
open a terminal. (The TRD files were extracted to your <wor ki ng_di r > in Download
the Targeted Reference Design Files, page 9).

2. Enter:
$ cd <working_dir>/kculO5_control _plane
$ sudo chmod +x quickstart.sh
$ sudo sh quickstart.sh

3. The TRD setup screen is displayed (Figure 3-8) and indicates detection of a PCle device
with an ID of 8011, a control plane design selection, and a control plane driver mode.
Click Install and the drivers are installed. This takes you to the Control and Monitoring
GUI as shown in Figure 3-12, page 26.

TRD Setup

Kintex UltraScale PCle Reference Design

Device:
Memory controller: Xilink Corporation Device 8011

Design Selection

@ FCle Based Accelerator @ EGihernet AXI-4 Stream =) Caontrol Plane

Driver Mode Selection for Control Plane Design

sl - 1| = -
& Control Flane

UG918_c3_10_021815

Figure 3-8: TRD Setup Screen with a PCle Device Detected
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Run the Design on a Windows 7 Host Computer
After booting the Windows OS, follow these steps:

1. Repeat the steps in section Disable Driver Signature Enforcement, page 9.

2. Open Device Manager (click Start > devmgmt.msc then press Enter) and look for the
Xilinx PCI Express Device as shown in Figure 3-9.

A Computer Management EI@

File Action ¥iew Help

@ | #FE HE &

;lé‘ Computer Management (Local|| a = xilink-PC Actions
a [f‘\; System Tools 8 Bluetooth Radios Torem e o
> @ Task Scheduler > -8 Computer n
> @ Event Viewer b g Disk drives More Actions
> @l Shared Folders b & Display adapters
» ¥ Local Users and Groups b & DVD/CD-ROM drives
> @EI' Perfermance "’t-‘, Hurnan Interface Devices
i=n Device Manager » g IDE ATA/ATAPI controllers
4 %5 Storage @ IEEE 1394 Bus host controllers
= Disk Management » == Keyboards
3 ::,, Services and Applications jf! Mice and other pointing devices
» Bl Monitors

» ¥ Metwork adapters
» -7 Other devices
D Processors
» % Sound, video and game controllers
» M Systern devices
b ! Universal Serial Bus controllers
a-8F Xilinx PCI Express Device
& Kilinx Kintex UltraScale XDMA adapter

UG918_c3_11_040715

Figure 3-9: Xilinx PCl Express Device in Device Manager
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3. Open a command prompt with administrator privileges, as shown in Figure 3-10.

']3 Default Programs

E_'.f Windows Update

|, Accessories
D Calculator
BH Command Prompt
@3 Connect to a Network
!_i Connect to a Pm_ier:tul':
=i Getting Started Open file location
&4 Math Input Panel % Morton AntiVirus

:-]] Motepad Add to archive...
e} Paint Add to "ecmd.rar”
%5 Remote Desktop Conn Compress and email...

L—T‘j Run Compress te "cmd.rar” and email
% Snipping Tool T

'_, Sound Recorder
F Sticky Notes
@ Sync Center Restore previous versions

Pin to Start Menu

78 Windows Explorer
=] WordPad
. Ease of Access Cut
1 Media Center
. System Tools
, Tablet PC Delete

; Windows PowerShell Rename

Send to

Copy

Back Morton File Insight

Properties

Shut down || #
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Figure 3-10: Command Prompt with Administrator Privileges
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4. Navigate to the folder where the reference design is copied:
cd <dir>\kculO5 control plane

5. Run the batch script qui ckstart _wi n7. bat :
qui ckstart _wi n7. bat

6. The screen in Figure 3-11 shows the TRD Setup screen of the GUI. Click Proceed to test
the reference design. This step takes you to the Control and Monitoring GUI as shown in
Figure 3-12, page 26.

'/ TRD Setup B

Kintex UltraScale PCIe Reference Design

Device:

Memory controller: Xilinx Corporation Device 8011

Design Selection

® ~3-MM Dataplane @ . Stream Dataplane Ol Control Plane

Driver Mode Selection for Control Plane Design

Caontrol Plane

UG918_c3-13_040715

Figure 3-11: GUI - TRD Setup Screen

PCI Express Control Plane TRD www.xilinx.com Send Feedback 25
UG918 (v2017.3) October 30, 2017 l—\/—l


http://www.xilinx.com
https://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG918&Title=KCU105%20PCI%20Express%20Control%20Plane%20TRD%20User%20Guide&releaseVersion=2017.3&docPage=25

8 XI LINX Chapter 3: Bringing Up the Design

ALL PROGRAMMABLE-~

Test the Reference Design

The control and monitoring GUI, shown in Figure 3-12, provides information on power and
FPGA die temperature, (PVTMON is mapped to BAR2), PCle Express Endpoint link status,
virtual address assigned to BARs, and user options to access BAR-mapped regions.

The following can be done through the main control and monitoring GUI:

« Read an address offset from BARA4.

« Write to an address offset from BAR4 by providing the offset value and data value to be
written.

« Obtain a dump of the data from a specific address offset from BAR4.

You can view the block diagram by clicking Block Diagram in top right corner of the screen
(Figure 3-12).

Kintex UltraScale PCle Design Control & Monitoring GUI x

Control Plane

PCle Endpoint Status

Die Temperature :
Offset:  OxO !
Link State
Link Speed -
Link Width Power (W)

0,00 0.25 0.50

Vendor ID 0x10EE
Device ID 0x8011

256
12

Endpoint BAR Information

Virt Addr OxFFFFC2000A100000
Size 1024K

BAR 2
Virt Addr OxFFFFC9000A280000
Size 1024K

EAR 4
Virt Addr OxFFFFC9000A400000
Size 1024K

= vCCint WMMGTvce M VCCaux W CChram

UG918_c3_14_040715

Figure 3-12: Control & Monitoring GUI

Click the X mark on the top right corner to close the GUI. On a Linux host computer, this
step uninstalls the drivers and returns the GUI to the TRD Setup screen. Close the TRD Setup
screen and power off the host machine and then the KCU105 board. On a Windows host
computer, this step returns to the TRD Setup screen.

To uninstall the drivers on a Windows host computer, use the following steps.
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Remove Drivers from the Host Computer
(Windows Only)

i} IMPORTANT: Shutdown the host computer and power off the KCU105 board. Then use the following
steps to remove the Windows drivers.

1. Power on the host computer and from Windows Explorer, navigate to the folder in which
the reference design is downloaded
(<di r>\kculO5_control _pl ane\ soft war e\ wi ndows\ ). Run the setup file with
administrator privileges.

Click Next after the InstallShield Wizard opens.
Select Remove and click Next.

Click Remove to remove drivers from the host system.

vk W

Click Finish to exit the wizard.
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Chapter 4

Implementing and Simulating the Design

This chapter describes how to implement and simulate the targeted reference design. The
time required to do so can vary from system to system depending on the control computer
configuration.

Note: All the steps mentioned in this chapter to run simulation and implementation should be run
on the control PC that has Vivado® tools installed.

Note: In Windows, if the path length is more than 260 characters, then design implementation or
simulation using the Vivado Design Suite might fail. This is due to a Windows OS limitation. Refer to
Refer to the following AR for more details: KCU105 Evaluation Kit Master Answer Record (AR

63175).

Implementing the Base Design

1. If not already done so, copy the reference design ZIP file to the desired directory on the
control PC and unzip the ZIP file. (The TRD files were extracted to your
<wor ki ng_di r > in Download the Targeted Reference Design Files, page 9.)

2. Open aterminal window on a Linux system with the Vivado environment set up, or open
a Vivado tools Tcl shell on a Windows system.

3. Navigate to the kcul05_cont rol _pl ane/ hardwar e/ vi vado/ scri pt s/ base
folder.

4. To run the implementation flow, enter:
$ vivado -source trd0l1 _base.tcl

This opens the Vivado Integrated Design Environment (IDE), loads the block diagram,
and adds the required top file and Xilinx design constraints (XDC) file to the project (see
Figure 4-1).
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Figure 4-1: Base Design—Project View

PCI Express Control Plane TRD www.xilinx.com Send Feedback 29
UG918 (v2017.3) October 30, 2017


http://www.xilinx.com
https://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG918&Title=KCU105%20PCI%20Express%20Control%20Plane%20TRD%20User%20Guide&releaseVersion=2017.3&docPage=29

& XILINX

ALL PROGRAMMABLE-~

Chapter 4: Implementing and Simulating the Design

5. In the Flow Navigator panel, click the Generate Bitstream option which runs synthesis,
implementation, and generates the BIT file (see Figure 4-2). Click Yes if a window
indicating No | npl ement ati on Results are avail abl e is displayed. The
generated bitstream can be found under the following directory:

kcul05 control pl ane/ hardware/vivado/runs_base/trd0O1l. runs/inpl 1.
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Implementing the User Extension Design

1. Open a terminal window on a Linux system with the Vivado environment set up, or open
a Vivado tools Tcl shell on a Windows system.

2. Navigate to the
kculO5 control pl ane/ hardware/vi vado/ scri pts/user _extn folder.

3. To run the implementation flow, enter:
$ vivado -source trdOl1l_user_extn.tcl

This opens the Vivado IDE, loads the block diagram, and adds the required top file and
XDC file to the project (see Figure 4-3).
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Figure 4-3: User Extension Design—Project View
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4. In the Flow Navigator panel, click the Generate Bitstream option which runs synthesis,
implementation, and generates the bit file (see Figure 4-4). The generated bitstream can
be found under the following directory:

kcul05_control _pl ane/ hardwar e/ vi vado/ runs_user _extn/trd01l. runs/
i mpl _1/
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Figure 4-4: User Extension Design—Generate Bitstream

Simulating the Base Design Using Vivado Simulator

The targeted reference design can be simulated using the Vivado simulator. The testbench

and the Endpoint PCle IP block are configured to use the PHY Interface for PCI Express
(PIPE) mode simulation.

The test bench initializes the bridge, does one double word (DW) write to BAR-mapped

address space, reads back from the same address, and compares the data with expected
pattern.
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Implementing and Simulating the Design

Simulation setup is provided only for the base design and not for the pre-built user

extension design.

Running Simulation Using the Vivado Simulator

1. Open a terminal window on a Linux system with the Vivado environment set up, or open
a Vivado tools Tcl shell on a Windows system.

2. Navigate to the kcul05_cont rol _pl ane/ har dwar e/ vi vado/ scri pt s/ base

folder.

3. To run simulation, enter:

$ vivado -source trd0l1l _base.tcl

This opens the Vivado IDE with the target simulator set to the Vivado Simulator

(Figure 4-5).

Help Q- Quick Access

File  Edt Flow Tools Window  Layout  View Ready
= W o~ = » B8 X = Default Layout -
Flow Navigator SRS BLOCK DESIGN - design_cp * ?
~ PROJECT MANAGER 5
Sources| Desig X Signals | 2 _ O [4 | Diagram x AddressEditor X 200
L settings
Q = Hp o Az 53 Ta——" ek e - °
Add Sources 4 Settings ==
& design_cp
Language Templates
et > Extemnal In
¥ 1P Catslog > Interface o 4
Project Settings Specify various settings associated to Simulation
> Ports I
General —_— 1
~ IPINTEGRATOR > Nets Bign
— Simulation Target simulator Vivado Simulator v
Create Block Design 2 Elabioraiion
> B axi_interc B Simulator language: Mixed v
nthesis
Open Block Design N Exp T : =
Car R R S e Implementation Simulation set £ sim_1 -
Bitstream :
> & proc_sys ) i Simulation top module name: | board E
~ » & pitmon, -
BReRATIH % pamon 3 ERF /| Clean up simulation files
> 4 xconstant] 0ol Settings.
Run Simulation ol e s E e
o i =
|P Defaults Compilation  Elaboration | Simulation | Netfist | Advanced X
v RTLANALYSIS | FAY I
Properties Source File —
> Open Elaborated Design e Ry
[l P & Display Verilog options: wverilog_define={SIMULATION 1} verilog_dir={c:/Haris/TRI lz‘ n u H—
WebTalk -
. Svewon
v Siiiea s Generics/Parameters options |I| -
l P Run Synthesis » Text Editor xsim.compile.tcl.pre
> Open Synthesized Design — S Pty Senulabors ssim.compile vhel.nosort 7
» Colors xsim.compile.xviog.nosort o
Selection Rules ~ v
~ IMPLEMENTATION
I Shortcuts description of it
» Run Implementation Strategies
> Open Implemented Design TclConsole > Window Behavior oo
| >
: Q = =
~ PROGRAM AND DEBUG v o~
I'E | @) g
¥ Generate Bitstream | # update call
! 4 set_propell
e il 4 update_conSTTETORIRE T TREIE SOOI
! 4 set_property source_momc_mode DisplayOnly [current_project]
| # reorder files -before ../../runa_base/trd0l.srcs/sources_l/irports/hdl/design cp Wrapper.v ../../../scurces/testbench/functional/sys_clk_gen.v
| ! $ update_compile order -fileset sources 1
.l # set_property synth checkpoint mode None [get files 8{runs}/§{proj_neme}.srcs/sources 1/bd/§{design_top}/${design_top}.bd]
< >

Figure 4-5:

PCI Express Control Plane TRD
UG918 (v2017.3) October 30, 2017

www.Xilinx.com

UG918_c4_05_070717

Base Design Project Settings for Simulation

33

| Send Feedback l


http://www.xilinx.com
https://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG918&Title=KCU105%20PCI%20Express%20Control%20Plane%20TRD%20User%20Guide&releaseVersion=2017.3&docPage=33

& XILINX

ALL PROGRAMMABLE-~

4.

File
= W«

Flow Navigat

Edit Flow  Tools

|| v PROJECT MANAGER

£ Settings
Add Sources
Language Templates

F IP Catalog

<

IPINTEGRATOR
Create Block Design
Open Block Design

Generate Block Design

<

SINULATION

Run Simulation

<

RTLANALYSIS

> Open Elaborate

v SYNTHESIS
» Run Synthesis

> Open Syntt

<

IMPLEMENTATION
P Runimplementation

> Openimpleme

<

PROGRAM AND DEBUG
1 Generate Bitstream

> Open Hardware Manager

Vivado Simulator

Window

Chapter 4:

Lagout  View  Help

E > B A X

Implementing and Simulating the Design

In the Flow Navigator panel, under Simulation, click Run Simulation and select Run
Behavioral Simulation. This generates all the simulation files, loads the Vivado
simulator, and runs the simulation. The result is shown in Figure 4-6.
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Chapter 5

Targeted Reference Design Details and
Modifications

This chapter describes the TRD hardware design and software components in detail, and
provides modifications to add an additional AXI block RAM controller to the design.

Hardware

The functional block diagram in Figure 5-1 identifies the different TRD hardware design
components. Subsequent sections discuss each of the components in detail.

KCU105 Evaluation Board
XCKU040-2FFVA1156E FPGA
Host Computer o
s
PROCESSOR S 2
@ % AXI Block RAM
= (PFO, BAR4)
PCle a B
B Root PCle B AXI PCle Z
GUI <> kel | |[] complex [ = Bridge S PVTMON
space) x1 Gen1 > ] 64 bits at i5 Registers | SYSMON
Link = )] 62.5 MHz | (PFO, BAR2)
= %
Wrapper (PFO, BAR4)
User Modification
Integrated block on FPGA Custom logic in FPGA . Third-party IP and FPGA

Software running on Component on host computer

B xilinx in-house IP
host computer UGS18_c5_01_021315

Figure 5-1: TRD Functional Block Diagram
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Endpoint Block for PCI Express
The PCI Express IP for is used in the following configuration:
« x1 Gen1 line rate (2.5 GT/s/lane/direction)

 Three 64-bit BARs

See LogiCORE IP UltraScale FPGAs Gen3 Integrated Block for PCl Express Product Guide
(PG156) [Ref 4] for more information.

DMA Bridge Core

The DMA bridge core includes an AXI-PCle bridge and Expresso DMA in one netlist bundle.
See the Northwest Logic Expresso DMA Bridge Core website to obtain a user guide [Ref 5].

Note: The IP netlist used in the reference design supports a fixed configuration where the number
of DMA channels and translation regions is fixed; for higher configurations of the IP, contact
Northwest Logic.

Note: The Northwest Logic Expresso IP provided with the design is an evaluation version of the IP.
It times out in hardware after 12 hours. To obtain a full license of the IP, contact Northwest Logic.

AXI-PCle Bridge

The AXI-PCle bridge translates protocol to support transactions between the PCle and AXI3
domains. It provides support for two ingress translation regions to convert PCle
BAR-mapped transactions to AXI3 domain transactions.

Bridge Initialization
The AXI-PCle bridge consumes transactions hitting BARO in the Endpoint.

« The bridge registers are accessible from BARO + 0x8000.
« During ingress translation initialization:
- Two ingress translations are enabled (0x800 and 0x820).

- Address translation is set up as shown in Table 5-1.

For example, assume that the PCle BAR2 physical address is 0x2E000000. Any memory
read request targeted to address Ox2E000000 is translated to 0x44A00000.

Table 5-1: Address Translation Maps

Ingress Source Base | Ingress Destination Base Comments
BAR2 0x44A00000 PCle BAR2 mapped to power monitor slave
BAR4 0xC0000000 PCle (BAR4) mapped to AXI block RAM
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« During bridge register initialization:
- Bridge base low (0x210) is programmed to (BARO + 0x8000).

- Bridge Control register (0x208) is programmed to set the bridge size and enable
translation.

« After bridge translation has been enabled, the ingress registers can be accessed with
Bridge Base + 0x800.

Expresso DMA
Key features of Expresso DMA are:

« High-Performance Scatter Gather DMA, designed to achieve full bandwidth of AXI and
PCle

« Separate source and destination scatter-gather queues with separate source and
destination DMA completion Status queues

+  DMA channels merge the source and destination scatter gather information

AXI Block RAM Controller

The AXI block RAM controller provides block RAM with an AXI4 memory-mapped interface.
This behaves as a register file in this design to which BAR-mapped transactions are
targeted.

See LogiCORE IP AXI Block RAM (BRAM) Controller Product Guide (PGO78) [Ref 6] for more
details.

AXI Interconnect

The AXI Interconnect is used to connect the various IPs together in a memory-mapped
system. The interconnect is responsible for:

« Converting AXI3 transactions from AXI-PCle bridge into AXI4 transactions for various
slaves

« Decoding address to target appropriate slave

See LogiCORE IP AXI Interconnect Product Guide (PG059) [Ref 7] for more details.
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Power and Temperature Monitoring

The design uses a SYSMON block to provide system power and die temperature monitoring
capabilities.The design uses a SYSMON block (17 channel, 200 ksps) to provide system
power and die temperature monitoring capabilities. The block provides analog-to-digital
conversion and monitoring capabilities. It enables reading of voltage and current on
different power supply rails (supported on the KCU105 board) which are then used to
calculate power.

A lightweight PicoBlaze™ controller is used to set up the SYSMON registers in continuous
sequence mode and read various rail data periodically. The output from PicoBlaze is made
available in block RAM and an FSM reads various rails from the block RAM (as shown in
Figure 5-2), and updates the user space registers. These registers can be accessed over PCle
through the BAR-mapped region.

The AXI4 Lite IPIF core is used in the design and the interface logic between the block RAM
and the AXI4 Lite IPIF reads the power and temperature monitor registers from block RAM.
Providing an AXI4 Lite slave interface adds the flexibility of using the module in other
designs.

| AXI4LITE

AXI4LITE to IPIF
Block RAM

—™ FSM (register space)

PicoBlaze

PVTMON Block A

Analog I/F UG918_c5_02_091514

Figure 5-2: Power and Temperature Monitoring Block

See the UltraScale Architecture System Monitor User Guide (UG580) [Ref 8] for more details.
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Data Flow

This section summarizes the TRD data flow.

Transmit Path

1. The GUI opens the driver interface for read/write functionality.

2. The GUI issues WRITE system calls for writing into BAR-mapped registers based on your
input.

3. The driver writes appropriate values into BAR-mapped registers.

Receive Path

1. The GUI issues a READ system call to read BAR-mapped registers based on your input.

2. The Character driver reads appropriate BAR-mapped registers and conveys the readings
to the GUI.

3. The GUI displays the read BAR-mapped register information.
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Software

Software Architecture

The software component of the TRD framework comprises a kernel space base driver
module (see Figure 5-3) and a user space GUI that controls design operation. The software’s
building blocks are designed with scalability in mind. Additional user-space applications
can be designed with the existing blocks.

GUI
A
UserSpace ]/ Driver interface
Kernel Space T TTTTTTTTTTTTTTTTTTTTTTTTTTTTTTToTos
Base Driver \i
Driver Entry:

ioctl, read, write

A A

Y

@nitor

Software

Hardware BAR-Mapped Access Power, Temperature
y vy Statistics

AXI-PCle Bridge (NWL)

UG918_c5_03_040615

Figure 5-3: TRD Architecture

Graphical User Interface
The user-space GUI is a Java-based GUI that provides these features:

« GUI management of the driver and device

o In Linux, the GUI installs the selected design mode drivers and can configure and
control device and test parameters.

o In Windows, the GUI can configure and control device and test parameters.
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« GUI front end graphical display of statistics collected from the underlying driver
through the driver interface.

The TRD demonstrates the use of PCle in control plane applications. A simple kernel driver
on a host computer demonstrates BAR-mapped single double word (DW) register transfers.

Apart from generic GUI functionality described previously, the GUI allows you to read from
or write to BAR-mapped registers in hardware and display them in a GUI window.

Reference Design Modifications

Adding a pre-built additional AXI block RAM controller is included in the TRD as an
extension of the base design. This section describes how to add an additional AXI block
RAM controller to the design and set up ingress translations through BAR4 to access this
memory space.

Rebuilding Hardware

A pre-built design script is provided that can be run to generate a bitstream with an
additional AXI block RAM controller added. The additional block RAM is mapped to AXI
address 0xDO00_0000. The steps needed to build the user modification design are
described in Chapter 4, Implementing and Simulating the Design.

Software Modification

f IMPORTANT: The pre-built user extention design can be tested only on Linux and not on Windows.
There is no support for the user extension design in the Windows platform.

In the software driver, access to newly added block RAM can be added as follows.

In the file sof twar e/l i nux_driver _app/driver/ctrl pl ane/ xpci e. c, under the
InitBridge function, the line can be changed as shown:

//- Program DST address to be AXI domain address for BRAM Controller

XTo_Out32 ((bar0_addr +REG_BRDG_BASE + REG_INGR_AXI_BASE + SECOND_TRANS
+OFFSET_INGR_AXI_DST 1O ), 0xC0000000);

//- Program DST address to be AXI domain address for BRAM Controller

XIo_Out32((bar0_addr +REG_BRDG_BASE + REG_INGR AXI BASE + SECOND_TRANS
+OFFSET_INGR_AXI_DST 1O ), 0xD0000000);

This maps the newly added block RAM controller to BAR4. With this minor change, the
same GUI can be used for read/write access.
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To enable read access to both block RAM controllers, an additional ingress translation
aperture can be mapped and the ReadUserReg function in the driver can be used to access
those registers. The display from the software driver can be seen in the system dmesg log.

The ability to read multiple user registers or block RAM controllers is not supported by the
GUI, and the aperture size is currently limited to 4K.
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Appendix A

Directory Structure

The directory structure for the TRD is shown in Figure A-1 and described in Table A-1. For
a detailed description of each folder, see the Readme file.

kcul05_control_plane

ﬁ hardware ﬁ ready_to_test é software readme
—\ ' sources
- linux_driver_app

{
hdl
» @ windows

constraints

\ 4

Y

Y

ip_package

o
|

—G vivado

testbench

UG918_aA 01_040315

Figure A-1: TRD Directory Structure
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Table A-1: Directory Description

Folder Description

readme A TXT file that includes revision history information, steps to implement and
simulate the design, required Vivado® tool software version, and known
limitations of the design (if any).

hardware Contains hardware design deliverables

sources

hdl Contains HDL files

constraints | Contains constraint files

ip_package | Contains custom IP packages

testbench Contains test bench files

vivado Contains scripts to create a Vivado Design Suite project and outputs of
Vivado runs
ready to test Contains the BIT file to program the KCU105 PCl Express® Control Plane
application
software Contains software design deliverables for Linux and Windows
linux_driver_app
windows
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Appendix B

Recommended Practices and
Troubleshooting in Windows

Recommended Practices

O RECOMMENDED: Make a backup of the system image and files using the Backup and Restore utility of
the Windows 7 operating system before installing reference design drivers. (As a precautionary
measure, a fresh installation of the Windows 7 OS is recommended for testing the reference design.)

Troubleshooting
Problem: The TRD Setup screen of the GUI does not detect the board.
Corrective Actions:

1. If the GUI does not detect the board, open Device Manager and see if the drivers are
loaded under Xilinx PCI Express Device.

2. If the drivers are not loaded, check the PCle Link Up LED on the board (see Figure 3-6).

3. If the drivers are loaded but the GUI is not detecting the board, remove non-present
devices from Device Manager using the following steps.

a. Open a command prompt with Administrator privileges.

b. At the command prompt, enter the following bold text:
set devmgr_show_nonpresent_devices=1
start devmgmt.msc

c. Click the View menu and select Show hidden devices on the Device Manager
window.

d. Non-present devices are indicated by a lighter shade of text.

e. Look for all the Non Present/Hidden devices. Right-click each one, and select
Uninstall. Remove the driver if prompted for it.

4. Invoke the GUI of the reference design and check if it detects the board.
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Appendix C

Additional Resources and Legal Notices

Xilinx Resources

For support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx
Support.

For continual updates, add the Answer Record to your myAlerts.

Solution Centers

See the Xilinx Solution Centers for support on devices, software tools, and intellectual
property at all stages of the design cycle. Topics include design assistance, advisories, and
troubleshooting tips.

References

The most up-to-date information for this design is available on these websites:

KCU105 Evaluation Kit website

KCU105 Evaluation Kit documentation

KCU105 Evaluation Kit Master Answer Record (AR 63175)

These documents and sites provide supplemental material:

1. Northwest Logic Expresso DMA Bridge Core

2. Vivado Design Suite User Guide Release Notes, Installation, and Licensing (UG973)
3. Kintex UltraScale FPGA KCU105 Evaluation Board User Guide (UG917)
4

LogiCORE IP UltraScale FPGAs Gen3 Integrated Block for PCl Express Product Guide
(PG156)

5. Northwest Logic PCl Express Solution
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6. LogiCORE IP AXI Block RAM (BRAM) Controller Product Guide (PG078)
7. LogiCORE IP AXI Interconnect Product Guide (PG059)
8. UltraScale Architecture System Monitor User Guide (UG580)
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